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      Chapter 1. Set Up Certificate Verification
      

      
          
            		
            Cisco UC
               		  Integration for IBM Sametime uses certificate validation to establish secure
               		  connections with servers. 
               		
            

            
            		
            When attempting to
               		  establish secure connections, servers present Cisco UC Integration for IBM
               		  Sametime with certificates. Cisco UC Integration for IBM Sametime validates
               		  those certificates against certificates in the Microsoft Windows certificate
               		  store. If the certificates are not present in the certificate store, the client
               		  prompts the user to confirm if they want to connect to the server. 
               		
            

            
            	 
         

         
      

      
      
      
         
         	Required Certificates

         
         	Get Certificates Signed by Certificate Authority

         
         	Server Identity in Certificates

         
         	Import Root Certificates on Client Computers

         
      

      
      
      
   
      
      
      Required
         	 Certificates
      

      
          
            		
            On-premises
               		  servers present the following certificates to establish a secure connection
               		  with Cisco UC Integration for IBM Sametime. 
               		
            

            
            		
            
            
               
                  
                     
                        	Server
                           					 
                           				  
                        
                        
                        	Type
                           					 of Certificate 
                           				  
                        
                        
                     

                     
                  
                  
                  
                     
                        	Cisco Unified Presence
                           				  
                        
                        
                        	HTTP(Tomcat)
                           					 
                           XMPP
                              					 
                           

                           
                           				  
                        
                        
                     

                     
                     
                        	Cisco
                           					 Unified Communications Manager IM and Presence 
                           				  
                        
                        
                        	HTTP
                           					 (Tomcat) 
                           					 
                           XMPP 
                              					 
                           

                           
                           				  
                        
                        
                     

                     
                     
                        	Cisco
                           					 Unified Communications Manager 
                           				  
                        
                        
                        	HTTP
                           					 (Tomcat) 
                           				  
                        
                        
                     

                     
                     
                        	Cisco
                           					 Unity Connection 
                           				  
                        
                        
                        	HTTP
                           					 (Tomcat) 
                           				  
                        
                        
                     

                     
                  
                  
               

               
            

            
            		
            Important:  
               		  
               
                  	 
                     				You should
                     				  apply the most recent system upgrade (SU) for Cisco Unified Presence or Cisco
                     				  Unified Communications Manager IM and Presence before you begin the certificate
                     				  signing process. 
                     				
                     
                     			 
                  

                  
                  	 
                     				The required
                     				  certificates apply to all server versions. For example, both Cisco Unified
                     				  Presence version 8.x and Cisco Unified Communications Manager IM and Presence
                     				  version 9.x and higher present the client with XMPP and HTTP certificates. 
                     				
                     
                     			 
                  

                  
                  	 
                     				Each node in
                     				  a cluster, subscribers and publishers, runs a Tomcat service and can present
                     				  the client with an HTTP certificate. 
                     				
                     
                     				You should
                     				  plan to sign the certificates for each node in the cluster. 
                     				
                     
                     			 
                  

                  
               

               
               		
            

            
            	 
         

         
      

      
      
      
         
      

      
      
      
   
      
      
      Get Certificates
         	 Signed by Certificate Authority
      

      
          
            		
            Cisco recommends
               		  using server certificates that are signed by one of the following types of
               		  Certificate Authority (CA): 
               		
            

            
            		
            Public CA- A
               		  third-party company verifies the server identity and issues a trusted
               		  certificate. 
               		
            

            
            		
            Private CA- You create
               		  and manage a local CA and issue trusted certificates. 
               		
            

            
            		
            The signing
               		  process varies for each server and can vary between server versions. You should
               		  consult the appropriate server documentation for detailed instructions on how
               		  to get certificates signed by a CA. However, the following steps provide a
               		  high-level overview of the procedure: 
               		
            

            
            	 
         

         Procedure

         
            
               
                  	Step 1  
                     
                  
                  	Generate a
                        			 Certificate Signing Request (CSR) on each server that can present a certificate
                        			 to the client. 
                        		  
               

               
               
                  	Step 2  
                     
                  
                  	Submit each
                        			 CSR to the CA. 
                        		  
               

               
               
                  	Step 3  
                     
                  
                  	Upload the
                        			 certificates that the CA issues to each server. 
                        		  
               

               
            

         

         

         
      

      
      
      
         
         	Certificate Signing Request Formats and Requirements

         
      

      
      
      
         
      

      
      
      
   
      
      
      Certificate
         	 Signing Request Formats and Requirements
      

      
          
            		
            Public CAs
               		  typically require CSRs to conform to specific formats. For example, a public CA
               		  might only accept CSRs that: 
               		
            

            
            		
            
               	Are Base64-encoded. 
                  		  
               

               
               	Do not contain certain
                  			 characters, such as @&!, in the Organization, OU, or other fields. 
                  		  
               

               
               	Use specific bit lengths in
                  			 the server's public key. 
                  		  
               

               
            

            
            		
            Likewise, if you
               		  submit CSRs from multiple nodes, public CAs might require that the information
               		  is consistent in all CSRs. 
               		
            

            
            		
            To prevent issues
               		  with your CSRs, you should review the format requirements from the public CA to
               		  which you plan to submit the CSRs. You should then ensure that the information
               		  you enter when configuring your server conforms to the format that the public
               		  CA requires. 
               		
            

            
            		
            One Certificate Per
                  			 FQDN: some public CAs sign only one certificate per fully qualified domain
               		  name (FQDN). 
               		
            

            
            		
            For example, to
               		  sign HTTP and XMPP certificates for a single Cisco Unified Communications
               		  Manager IM and Presence node, you might need to submit each CSR to different
               		  public CAs. 
               		
            

            
            	 
         

         
      

      
      
      
         
      

      
      
      
   
      
      
      Server Identity in
         	 Certificates
      

      
          
            		 
            		
            As part of the
               		  signing process, the CA specifies the server identity in the certificate. When
               		  the client validates that certificate, it checks that: 
               		
            

            
            		
            
               	 
                  			 A trusted
                  				authority has issued the certificate. 
                  			 
                  
                  		  
               

               
               	 
                  			 The identity
                  				of the server that presents the certificate matches the identity of the server
                  				specified in the certificate. 
                  			 
                  
                  		  
               

               
            

            
            		
            
               
                  	[image: ../images/note.gif]
Note
                  	


Public CAs
                     		  generally require a fully qualified domain name (FQDN) as the server identity,
                     		  not an IP address. 
                     		
                     

                  
               

            

            
            		
            Identifier Fields 
               		
            

            
            		
            The client checks
               		  the following identifier fields in server certificates for an identity match: 
               		
            

            
            		
            XMPP certificates 
               		
               
                  	
                     			 SubjectAltName\OtherName\xmpAddr
                     			 
                     
                     		  
                  

                  
                  	 
                     			 SubjectAltName\OtherName\srvName
                     			 
                     
                     		  
                  

                  
                  	 
                     			 SubjectAltName\dnsNames
                     			 
                     
                     		  
                  

                  
                  	 
                     			 Subject CN
                     			 
                     
                     		  
                  

                  
               

               
               		
            

            
            		
            HTTP certificates 
               		
               
                  	 
                     			 SubjectAltName\dnsNames
                     			 
                     
                     		  
                  

                  
                  	 
                     			 Subject CN
                     			 
                     
                     		  
                  

                  
               

               
               		
            

            
            		
            
               
                  	[image: ../images/tip.gif]
Tip
                  	


The 
                     		  Subject CN field can contain a wildcard (*) as
                     		  the leftmost character, for example, *.cisco.com 
                     		
                     

                  
               

            

            
            		
            Prevent Identity
                  			 Mismatch 
               		
            

            
            		
             If users attempt
               		  to connect to a server with an IP address, and the server certificate
               		  identifies the server with an FQDN, the client cannot identify the server as
               		  trusted and prompts the user. 
               		
            

            
            		
            If your server
               		  certificates identify the servers with FQDNs, you should plan to specify each
               		  server name as FQDN throughout your environment. 
               		
            

            
            	 
         

         
      

      
      
      
         
         	Provide XMPP Domain to Clients

         
      

      
      
      
         
      

      
      
      
   
      
      
      Provide XMPP
         	 Domain to Clients
      

      
          
            		
            The client
               		  identifies XMPP certificates using the XMPP domain, rather than FQDN. The XMPP
               		  certificates must contain the XMPP domain in an identifier field. 
               		
            

            
            		
            When the client
               		  attempts to connect to the presence server, the presence server provides the
               		  XMPP domain to the client. The client can then validate the identity of the
               		  presence server against the XMPP certificate. 
               		
            

            
            		
            Complete the
               		  following steps to ensure the presence server provides the XMPP domain to the
               		  client: 
               		
            

            
            	 
         

         Procedure

         
            
               
                  	Step 1  
                     
                  
                  	 Open the
                        			 administration interface for your presence server, as follows: 
                        		    
                     			 
                     Cisco Unified
                           				  Communications Manager IM and Presence 
                        			 
                     

                     
                     			 
                     Open the 
                        				Cisco Unified CM IM and Presence Administration 
                           				interface. 
                        			 
                     

                     
                     		    
                     			 
                     Cisco Unified
                           				  Presence 
                        			 
                     

                     
                     			 
                     Open the 
                        				Cisco Unified Presence Administration 
                           				interface. 
                        			 
                     

                     
                     		  
                  
               

               
               
                  	Step 2  
                     
                  
                  	Select 
                        			 Systerm > Security > Settings. 
                        		  
               

               
               
                  	Step 3  
                     
                  
                  	Locate the 
                        			 XMPP
                           				Certificate Settings section. 
                        		  
               

               
               
                  	Step 4  
                     
                  
                  	Specify the
                        			 presence server domain in the following field:Domain name for XMPP
                           				Server-to-Server Certificate Subject Alternative Name. 
                        		  
               

               
               
                  	Step 5  
                     
                  
                  	Select the
                        			 following checkbox: 
                        			 Use
                           				Domain Name for XMPP Certificate Subject Alternative Name. 
                        		  
               

               
               
                  	Step 6  
                     
                  
                  	Select 
                        			 Save. 
                        		  
               

               
            

         

         

         
      

      
      
      
         
      

      
      
      
   
      
      
      Import Root
         	 Certificates on Client Computers
      

      
          
            		
            Every server
               		  certificate should have an associated root certificate present in the trust
               		  store on client computers. Cisco UC Integration for IBM Sametime validates the
               		  certificates that servers present against the root certificates in the trust
               		  store. 
               		
            

            
            		
            If you get server
               		  certificates signed by a public CA, the public CA should already have a root
               		  certificate present in the trust store on the client computer. In this case,
               		  you do not need to import root certificates on the client computers. 
               		
            

            
            		
            You should import
               		  root certificates into the Microsoft Windows certificate store if: 
               		
            

            
            		
            
               	 
                  			 The
                  				certificates are signed by a CA that does not already exist in the trust store,
                  				such as a private CA. 
                  			 
                  
                  			 Import the
                  				private CA certificate to the Trusted Root Certification Authorities store. 
                  			 
                  
                  		  
               

               
               	 
                  			 The
                  				certificates are self-signed. 
                  			 
                  
                  			 Import
                  				self-signed certificates to the Enterprise Trust store. 
                  			 
                  
                  		  
               

               
            

            
            		
            Important:  
               		  
               If root
                  			 certificates are not present in the trust store, Cisco UC Integration for IBM
                  			 Sametime prompts users to accept certificates from each server in your
                  			 environment. 
                  		  
               

               
               		  
               When the client
                  			 prompts users to accept a certificate, users can: 
                  		  
               

               
               		  
               Accept the certificate 
                  		  
               

               
               		  
               The client saves
                  			 the certificate to the Enterprise Trust store. 
                  		  
               

               
               		  
               Decline the certificate
                  			 
                  		  
               

               
               		  
               The client: 
                  		  
               

               
               		  
               
                  	Does not save the
                     				certificate. 
                     			 
                  

                  
                  	Does not connect to the
                     				server. 
                     			 
                  

                  
                  	Displays an error
                     				notification. 
                     			 
                  

                  
               

               
               		  
               When users
                  			 restart the client, it prompts them to accept the certificate again. 
                  		  
               

               
               		
            

            
            		
            You can use any
               		  appropriate method to import certificates into the Microsoft Windows
               		  certificate store, including the following. For detailed instructions on
               		  importing certificates, refer to the appropriate Microsoft documentation. 
               		
               
                  	Use the 
                     			 Certificate
                        				Import Wizard to import certificates individually. 
                     		  
                  

                  
                  	Deploy certificates to
                     			 users with the CertMgr.exe command line tool on Microsoft Windows Server. 
                     		  
                  

                  
               

               
               		
               
                  
                     	[image: ../images/note.gif]
Note
                     	


This option
                        		  requires you to use the Certificate Manager too, CertMgr.exe, not the
                        		  Certificates Microsoft Management console, CertMgr.msc. 
                        		
                        

                     
                  

               

               
               		
               
                  	Deploy certificates to
                     			 users with a Group Policy object (GPO) on Microsoft Windows Server. 
                     		  
                  

                  
               

               
               		
            

            
            	 
         

         
      

      
      
      
         
      

      
      
      
   
      
      
      Chapter 2. Integration Deployment
      

      
      
         
         	Integration Deployment Methods

         
         	Deploy the Integration

         
         	Install Cisco Medianet

         
         	User preparation for integration setup and use

         
      

      
      
      
   
      
      
      Integration Deployment Methods

      
         
            The primary method to deploy the integration is to use a  widget to deploy its features to an existing IBM Lotus
               Notes client. The widget uses a combination of the widgets
               catalog, an NSF-based update site in which the feature resides, an
               XML file attached to the widget that calls the feature update
               site, and Domino policy or Eclipse preferences.
            

            
            Alternatively, users can manually install the integration on their workstations. With
               this method, you must provide users with the URL of the update
               site.
               
            

            
         

         
      

      
      
      
         
      

      
      
      
   
      
      
      Deploy the Integration

      
         Before You BeginBefore you deploy Cisco UC Integration for IBM Sametime, an administrator must consider factors such as:
               
                  	Whether to enable or disable voicemail
                     
                  

                  
                  	Whether to enable or disable the phone status feature
                     
                  

                  
                  	Whether to enable or disable the use my phone for calls phone mode 
                     
                  

                  
                  	Whether to enable or disable the use my computer for calls phone mode
                     
                  

                  
                  	Which phone mode to set as the default for users
                     
                  

                  
                  	Whether video should start automatically for all users. Each user can choose, individually, to disable the feature, but concurrent
                     widespread use might drain network resources
                     
                  

                  
               

               
            

            
         

         Procedure

         
            
               
                  	Step 1  
                     
                  
                  	Gather requirements for your users, such as supported versions of software for the system, including user
                        workstations.
                         
                     For more information, see the Release Notes for Cisco UC Integration for IBM Sametime.
                     

                     
                  
               

               
               
                  	Step 2  
                     
                  
                  	Provision users in Cisco Unified Communications Manager.
                         
                     For information on how to set up users in Cisco Unified Communications Manager, see:

                     
                     
                        	
                           
                           Cisco Unified Communications Manager Administration
                              Guide
                           
                        

                        
                        	Cisco Unified Communications Manager System Guide
                           
                        

                        
                     

                     
                  
               

               
               
                  	Step 3  
                     
                  
                  	Provision users for computer-based phone features, such as  Cisco Unified Communications Manager IM and Presence Service.
                         
                     
                        
                           	Note   
                                 
                                 
                           	
                              Cisco Unified Presence is no longer a standalone product, but is now a feature within Cisco Unified Communications Manager.
                                 In UC 9.0, the Presence and IM feature has been integrated  within Cisco Unified Communications Manager and is referred to
                                 as “Cisco Unified Communications Manager IM and Presence Service.”
                              

                              
                              While some customers might still be using Cisco Unified Presence, this document will refer to the feature as “IM and Presence
                                 Service.”
                              

                              
                           
                        

                     

                     
                  
               

               
               
                  	Step 4  
                     
                  
                  	Associate users with the Standard 
                        CTI- enabled user group in Cisco Unified Communications Manager.
                         
                     This step is required if users use the Control Desk Phone feature. See existing dialing rules in Cisco Unified Communications
                        Manager Administration Guide.
                        
                     

                     
                  
               

               
               
                  	Step 5  
                     
                  
                  	Verify that application dial rules are set up in Cisco Unified
                        Communications Manager.
                        
               

               
               
                  	Step 6  
                     
                  
                  	Provision users in the IM and Presence Service. 
                     This step is required for any user that enables the Enable Phone Status feature.
                        
                     

                     
                  
               

               
               
                  	Step 7  
                     
                  
                  	Configure Cisco Unified Communications Manager Capability
                        Assignments to enable licenses for the IM and Presence Service.
                         
                     For license requirements, see the Release Notes for Cisco UC Integration for IBM Sametime. For configuration instructions, see Cisco Unified Communications Manager
                           Administration Guide.
                        
                     

                     
                  
               

               
               
                  	Step 8  
                     
                  
                  	Determine the server update site, the location from which Cisco UC Integration for IBM Sametime installs on user workstations.
                        
               

               
               
                  	Step 9  
                     
                  
                  	Set up a push update. 
                     If you do not set up a push update for the standalone plug-in and the widget update for the embedded plug-in, users manually
                        install the plug-in on their client workstations.
                        See the “Installation Methods” section for more information.
                     

                     
                  
               

               
               
                  	Step 10  
                     
                  
                  	Prepare users to install and use the plug-in.
                        
                         
                     Provide users with the Quick Start Guide for Cisco UC Integration for IBM Sametime.
                        
                     

                     
                  
               

               
            

         

         

         
      

      
      
      
         
      

      
      
      
   
      
      
      Install Cisco Medianet

      
         
            Install for Traffic Marking

            
            Cisco Medianet provides a Microsoft Windows service that works with Cisco Prime Collaboration Manager and Cisco Medianet-enabled routers to ensure that Cisco UC Integration for IBM Sametime can send audio media and video media on your network
               with minimum latency or packet loss.
            

            
            Before Cisco UC Integration for IBM Sametime sends audio media or video media, it checks for the Cisco Medianet service. If the service exists on the computer, Cisco UC Integration for IBM Sametime provides flow information to the Cisco Medianet service. The service then signals the network so that routers classify the flow and provide priority to the Cisco UC Integration
               for IBM Sametime traffic. If the service does not exist, Cisco UC Integration for IBM Sametime does not use it and sends audio
               media and video media as normal. However, Cisco UC Integration for IBM Sametime checks for the Cisco Medianet service for each audio call or video call.
            

            
            Install for Desk Phone Video Capabilities

            
            You must install Cisco Medianet to enable desk phone video capabilities. Cisco Medianet provides a driver that enables Cisco UC Integration for IBM Sametime to do the following:
               
                  	Discover the desk phone device.
                     
                  

                  
                  	Establish and maintain a connection to the desk phone device using the CAST protocol.
                     
                  

                  
               

               For more information, see Desk Phone Video Configuration.
            

            
            
         

         
         Before You BeginTo install Cisco Medianet for traffic marking, you must do the following:
               
                  	Install Cisco Prime Collaboration Manager.
                     
                  

                  
                  	Install routers or switches enabled for Cisco Medianet where appropriate.
                     
                  

                  
                  	Configure your network to handle the metadata attributes that Cisco Medianet applies to applications.
                     Note that not all devices on your network must support Cisco Medianet. The first hop should prioritize traffic based on the metadata attributes from Cisco Medianet. As the traffic traverses the network, all other devices should also prioritize that traffic unless you configure policies
                     on those devices to handle the traffic differently. See the Medianet Knowledge Base Portal for detailed information on configuring
                     your network.
                     
                  

                  
               

               
            

            
            
               Important: 
                  
                     	Cisco UC Integration for IBM Sametime supports the Cisco Media Service Interface version 3.2.1 (msi_setup-3-2-1-0-5732).
                        
                     

                     
                     	Cisco UC Integration for IBM Sametime does not support Cisco Medianet on Microsoft Windows Vista.
                        
                     

                     
                  

                  
               

               
            

            
         

         Procedure

         
            
               
                  	Step 1  
                     
                  
                  	Download the Cisco Media Services Interface installation program from the Cisco UC Integration for IBM Sametime download site on Cisco.com.

               

               
               
                  	Step 2  
                     
                  
                  	Install the Cisco Medianet service on each computer on which you install Cisco UC Integration for IBM Sametime. 
                     See the appropriate Cisco Medianet  documentation for installing the service.
                     

                     
                  
               

               
            

         

         

         
      

      
      
      
         
      

      
      
      
   
      
      
      User preparation for integration setup and use

      
         When deciding which information and instructions to provide to users, consider the following factors:

         
         
            	Which integration features you enable  
               
            

            
            	Whether or not you set up the features to install automatically
               
            

            
            	Which settings you preconfigure with the update site files
               
            

            
         

         
         To install and configure the integration, ensure that your users have the following:

         
         
            	Access to a supported version of IBM Sametime or IBM Lotus Notes and instructions for installation, if needed
               
            

            
            	 Information about the features that are supported in your deployment
               
            

            
            	  Access to the Quick Start Guide for Cisco UC Integration for IBM Sametime for the following:
               
               
                  	The URL for the update site, if users must install the integration itself, and installation instructions
                     
                  

                  
                  	Applicable values to use for system settings such as servers and configuration instructions
                     
                  

                  
                  	 Information about how to get support
                     
                  

                  
               

               
            

            
         

         
      

      
      
      
         
      

      
      
      
   
      
      
      Chapter 3. Integration Site Setup Instructions
      

      
      
         
         	Set up Local Directory

         
         	File Uploads

         
      

      
      
      
   
      
      
      Set up Local Directory

      Procedure

         
            
               
                  	Step 1  
                     
                  
                  	Create a local working directory to hold the integration files that users will install on their workstations.
               

               
               
                  	Step 2  
                     
                  
                  	Navigate to the Cisco Unified Communications with IBM Sametime download
                        page: 
                     https:/​/​communities.cisco.com/​community/​technology/​collaboration/​usergroups/​collaboration/​cuciibmeap/​downloads

                     
                     Then, sign in as a registered Cisco.com user.

                     
                  
               

               
               
                  	Step 3  
                     
                  
                  	Download the 
                        
                        zip file that contains the integration files.
                        
               

               
               
                  	Step 4  
                     
                  
                  	Extract the files from the zip file to the directory that you
                        created in
                        Step 1. 
                     You can also order Cisco UC Integration for IBM Sametime from Cisco on CD.

                     
                  
               

               
            

         

         

         What to Do Next
            Go to “Configure Phone Control and Presence with the Configuration Tool.” 

            
         

      

      
      
      
         
      

      
      
      
   
      
      
      File Uploads

      
         Use the following procedures to upload files to the update site. The files and folders that you copy to the update site differ,
            depending on whether you are setting up a new site or modifying an existing one.
         

         
         
            	Upload files to new site
               
            

            
            	Upload files to existing site
               
            

            
         

         
      

      
      
      
         
         	Upload Files to New Site

         
         	Upload Files to Existing Site

         
      

      
      
      
         
      

      
      
      
   
      
      
      Upload Files to New Site

      
         
            Copy the entire UpdateSite directory from your local working CUCIIBM_RELEASE_9.0.X directory (where X represents the current
               release number) to the web server that will host the update site.
            

            
         

         
      

      
      
      
         
      

      
      
      
   
      
      
      Upload Files to Existing Site

      Procedure

         
            
               
                  	Step 1  
                     
                  
                  	Replace the site.xml file on the update site with a copy of the site.xm file from your local working CUCIIBM_RELEASE_9.0.X/UpdateSite
                        directory (where X represents the current release number).
               

               
               
                  	Step 2  
                     
                  
                  	Copy all files in your local working CUCIIBM_RELEASE_9.0.X/UpdateSite/features directory to the features directory of the
                        update site.
               

               
               
                  	Step 3  
                     
                  
                  	Copy all files in your local working CUCIIBM_RELEASE_9.0.X/UpdateSite/plugins directory to the plugins directory of the update
                        site.
               

               
            

         

         

         
      

      
      
      
         
      

      
      
      
   
      
      
      Chapter 4. Integration Configuration
      

      
      
         
         	Configure LDAP with the Configuration Tool

         
         	Configure Voicemail Settings with the Configuration Tool

         
         	Configure Phone Control and Presence with the Configuration Tool

         
         	Credential Synchronization

         
         	Phone Number Retrieval

         
         	Enhanced LDAP Search Options

         
         	Enable Live Text Support

         
      

      
      
      
   
      
      
      Configure LDAP  with the Configuration Tool

      
         
            The default LDAP settings in this section represent common
               configurations. As an administrator, you must determine if these settings
               are appropriate for your specific configuration and adjust them as
               necessary.
            

            
            Using LDAP with Cisco Phone Control and Presence is optional. However, if
               you do not use LDAP, some of the Phone Control and Presence
               functionality is diminished. Phone Control and Presence uses LDAP
               for the following reasons:
            

            
            
               	To resolve incoming callers as Sametime contacts. Sametime does not provide a way to look up a contact using a phone number.
                  Without LDAP, incoming calls display the caller number without a contact name, because the number cannot be mapped to a Sametime
                  contact without LDAP
                  
               

               
               	To retrieve additional phone numbers for Sametime contacts. Without LDAP, only the primary number from the Business Card is
                  used.
                  
               

               
               	To provide an additional way to map a Sametime contact to an IM and Presence Service user in order to retrieve the phone status
                  for that user. If this mapping can be achieved using an attribute from the Business Card, then the phone status can be retrieved
                  without using LDAP.
                  
               

               
            

            
            If you are using LDAP, Cisco Unified Communications Manager and the Sametime server should use the same LDAP directory server,
               or
               the directory servers must use the same unique user ID to represent
               the same user in each directory.
               
                  
                     	[image: ../images/note.gif]
Note
                     	



                        LDAP settings are connected to other tabs in the Configuration Tool. If you make changes to the LDAP settings and save the
                           settings, you must also navigate to the Phone Control and Presence tab, and select Save from the File menu before exiting.
                        

                        
                        

                     
                  

               

               
            

            
         

         Procedure

         
            
               
                  	Step 1  
                     
                  
                  	Download the Configuration Tool zip file and unzip the file to a local directory.
               

               
               
                  	Step 2  
                     
                  
                  	Navigate to the directory where you installed the Configuration Tool files and double-click ciscocfg.exe.
               

               
               
                  	Step 3  
                     
                  
                  	In the Choose an Update Site dialog box, enter the path of the Update Site directory that you created in the section, "Set
                        up local directory". Then, click OK.
               

               
               
                  	Step 4  
                     
                  
                  	Click the LDAP tab, if it is not already selected.
               

               
               
                  	Step 5  
                     
                  
                  	Enter values in the applicable fields: 
                     

                     
                     [image: ../images/346317.jpg]

                     
                     

                     
                     
                     
                        
                        
                           
                              	Field or Option Name
                              
                              	Description
                           

                        
                        
                        
                           
                              	Directory Server Settings
                                    
                              
                              	
                                 The settings in this section define the directory and relevant attributes that the plug-in
                                    can search to find usernames, based on incoming phone numbers.
                                    
                                 

                                 
                              
                              
                           

                           
                           
                              	Server	
                              
                              	
                                 Enter the name or IP address of the LDAP server.

                                 
                              
                              
                           

                           
                           
                              	Port
                              
                              	
                                 Enter the number of the port that is used to communicate with the LDAP
                                    server.
                                 

                                 
                              
                              
                           

                           
                           
                              	Search Base	
                              
                              	
                                 Enter the base (or root) of the directory service in which to
                                    search for names. The value must match the one that was  configured on the
                                    Sametime server. If LDAP is used for the directory service, you can
                                    derive the setting directly from there. If Domino is used instead,
                                    find the equivalent search base on its LDAP interface.
                                 

                                 
                              
                              
                           

                           
                           
                              	Display Name Attribute	
                              
                              	
                                 Enter the LDAP attribute that is used as the display name for the
                                    caller.
                                 

                                 
                              
                              
                           

                           
                           
                              	Attribute for Lookup in Sametime
                              
                              	
                                 Enter the LDAP attribute that is used to search for the caller in
                                    Sametime.
                                    
                                 

                                 
                              
                              
                           

                           
                           
                              	Authentication Credentials
                              
                              	
                                 Use the settings in this section to enter information that authenticates with the directory server.

                                 
                              
                              
                           

                           
                           
                              	Authentication Required	
                              
                              	
                                 Select this option if the server requires authentication. The following two fields are active only if this option is selected.

                                 
                              
                              
                           

                           
                           
                              	Distinguished Name
                              
                              	
                                 Enter
                                    the distinguished name to authenticate with the
                                    directory service.
                                    
                                 

                                 
                              
                              
                           

                           
                           
                              	Password	
                              
                              	
                                 Enter
                                    the password to authenticate with the directory
                                    service.
                                    
                                 

                                 
                              
                              
                           

                           
                           
                              	Directory Type for Sametime Server
                              
                              	
                                 Choose one of the following options:
                                    
                                       	LDAP: Select this option if the IBM Sametime server uses an LDAP server for directory service.
                                          If IBM Lotus Sametime uses an LDAP attribute for the internal user ID, check the Use Attribute as Internal ID of Sametime User check box and enter the name of the LDAP attribute.
                                          
                                       

                                       
                                       	Domino: Select this option if the IBM Lotus Sametime server uses IBM Lotus Domino for the directory service.
                                          See the IBM Sametime documentation for information. 
                                          
                                       

                                       
                                    

                                    
                                 

                                 
                              
                              
                           

                           
                        
                     

                     
                  
               

               
               
                  	Step 6  
                     
                  
                  	From the File menu in the Configuration Tool window, select Save.
               

               
               
                  	Step 7  
                     
                  
                  	From the File menu in the Configuration Tool window, select Exit. 
                     
                        
                           	Note   
                                 
                                 
                           	
                              Confirm that you have saved your changes in the Cisco Unified
                                 Communications with IBM Sametime Configuration Tool window.
                                 Otherwise, all unsaved changes will be lost when you close the
                                 window.
                                 
                              

                              
                           
                        

                     

                     
                  
               

               
               
                  	Step 8  
                     
                  
                  	For configuration changes to take effect, either set up IBM Sametime to automatically update users by using a push update,
                        or instruct users to update the plug-in from their IBM Sametime client.
               

               
            

         

         

         What to Do Next
            To configure the voicemail feature, go to “Configure Phone Control and Presence with the Configuration Tool.”

            
         

      

      
      
      
         
      

      
      
      
   
      
      
      Configure Voicemail Settings with the Configuration Tool

      Procedure

         
            
               
                  	Step 1  
                     
                  
                  	Navigate to the ciscocfg directory of the extracted files. 
               

               
               
                  	Step 2  
                     
                  
                  	Double-click ciscocfg.exe to start the Configuration Tool.
               

               
               
                  	Step 3  
                     
                  
                  	Click OK.
               

               
               
                  	Step 4  
                     
                  
                  	Click the Voicemail tab and enter the values in the applicable fields. 
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                              	Field Name
                              
                              	Description
                           

                        
                        
                        
                           
                              	Feature Control
                              
                              	
                                 This section contains the option to enable or disable the voicemail feature for your users.

                                 
                              
                              
                           

                           
                           
                              	Enable Voicemail	
                              
                              	
                                 Check this check box to enable the voicemail feature for users.

                                 
                              
                              
                           

                           
                           
                              	Mail Store Connection Settings
                              
                              	
                                 Use the fields and options in this section to configure the voicemail server.

                                 
                              
                              
                           

                           
                           
                              	Server		
                              
                              	
                                  For Cisco Unity Connection, enter the name or IP address of the Connection server.

                                 
                              
                              
                           

                           
                           
                              	LDAP Attributes
                              
                              	
                                 Use the fields in this section to enter LDAP configuration information for the voicemail feature.

                                 
                              
                              
                           

                           
                           
                              	User ID
                              
                              	
                                 Enter the LDAP user attribute that contains the user ID in voice
                                    messages so that a directory search can find and display the username.
                                    
                                 

                                 
                              
                              
                           

                           
                           
                              	Phone Numbers
                              
                              	
                                 Enter the LDAP phone attributes that contain the caller ID in voice messages so that a directory search can replace the phone
                                    number with the caller name on voicemail.
                                 

                                 
                              
                              
                           

                           
                           
                              	Logging	
                              
                              
                              	
                                 Use the option in this section to activate logging.

                                 
                              
                              
                           

                           
                           
                              	Enable Detailed Logging
                              
                              	
                                 Check this check box to enable detailed logging.
                                    
                                 

                                 
                                 
                                    
                                       	Note   
                                             
                                             
                                       	
                                          Enable detailed logging only for troubleshooting. Otherwise, the
                                             logging will affect system performance.
                                             
                                          

                                          
                                       
                                    

                                 

                                 
                              
                              
                           

                           
                        
                     

                     
                  
               

               
               
                  	Step 5  
                     
                  
                  	Select File > Save in the Configuration Tool window.
               

               
            

         

         

         What to Do Next
            Go to the next section, "Configure Phone Control and Presence with the Configuration Tool."

            
         

      

      
      
      
         
      

      
      
      
   
      
      
      Configure Phone Control and Presence with the Configuration Tool

      
         
            The default Phone Control and Presence  settings in this section represent common
               configurations. As an administrator, you must determine if these settings
               are appropriate for your specific configuration and adjust them as
               necessary.
            

            
            Use the Configuration Tool to specify the update site files and to configure settings that apply to users of the plug-in.
               You can use the tool for configuring new installations of the plug-in, and for updating user configuration information after
               the plug-in is installed.
            

            
            For configuration changes to take effect, you must either set up
               IBM Sametime to automatically update users by using a push
               update, or instruct users to update the plug-in from their IBM Sametime Connect client.
               
            

            
            
               
                  	[image: ../images/note.gif]
Note
                  	



                      For initial migration to CUP server, it is strongly recommended that you migrate the buddy list data for the Sametime users
                        to the CUP server, using batch scripts. Failure to migrate the buddy list data can result in very heavy traffic on the Cisco
                        Unified Presence server when Sametime users initially log in to that server. As a result, this traffic might hamper the reaction
                        time of the Cisco Unified Presence  server.
                     

                     
                     

                  
               

            

            
         

         
         Before You BeginUnderstand that your saved field settings will overwrite corresponding user settings when the configuration feature is installed
               on client workstations.
            

            
         

         Procedure

         
            
               
                  	Step 1  
                     
                  
                  	Navigate to the ciscocfg directory and double-click ciscocfg.exe to start the Configuration Tool.
               

               
               
                  	Step 2  
                     
                  
                  	Specify the location of the local working CiscoUCIntegrationWithST/UpdateSite directory in the Update Site Selection window.
               

               
               
                  	Step 3  
                     
                  
                  	Select OK.
               

               
               
                  	Step 4  
                     
                  
                  	Select the Phone Control and Presence tab and enter the values in the applicable fields: 
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                              	Field or Option Name
                              
                              	Description
                           

                        
                        
                        
                           
                              	Feature Control
                                    
                              
                              	
                                 The options in this section enable and disable phone control features for users and determine the default behavior of these
                                    features.
                                    
                                 

                                 
                              
                              
                           

                           
                           
                              	Enable Phone Status
                              
                              	
                                 Check this check box to enable the phone status feature for all users.

                                 
                              
                              
                           

                           
                           
                              	 Enable Use My Computer for Calls
                              
                              	
                                 Check this check box to enable the Use My Computer for Calls phone mode for all users.

                                 
                              
                              
                           

                           
                           
                              	 Enable Use My Phone for Calls
                              
                              	
                                 Check this check box to enable all users who have desk phones to control their phones through IBM Sametime. 

                                 
                              
                              
                           

                           
                           
                              	Default Phone Mode
                              
                              	
                                 Select Use My Computer for Calls or Use My Phone for Calls as the default phone mode for all users. This setting applies only if you
                                    choose to enable both phone modes.
                                 

                                 
                              
                              
                           

                           
                           
                              	Start Calls with Video
                              
                              	
                                 Select Always Start Calls with Video or Never Start Calls with Video as the default video mode for all users.
                                 

                                 
                              
                              
                           

                           
                           
                              	User Authentication Options
                              
                              	
                                 Choose from one of the following options: 
                                    
                                       	No Credential Synchronization: Select this option if you do not intend to synchronize passwords for users.
                                          
                                       

                                       
                                       	 Sametime Credentials: Select this option if users have the same user ID and password for the IM and Presence Service and Sametime Connect, and
                                          you want to set these fields for all users.
                                          
                                       

                                       
                                       	  Synchronized Cisco UC Credentials: Select this option if you want users to enter their IM and Presence Service server credentials into Sametime Connect.
                                          
                                       

                                       
                                    

                                    
                                 

                                 
                              
                              
                           

                           
                           
                              	Cisco Unified Communications Manager
                              
                              	
                                 The fields and options in this section configure the integration with your phone and presence servers.

                                 
                              
                              
                           

                           
                           
                              	CCMIP Server
                              
                              	
                                 Enter the name or IP address of the CCMIP server.

                                 
                              
                              
                           

                           
                           
                              	TFTP Server
                              
                              	
                                 Enter the name or IP address of the TFTP server.
                                    
                                 

                                 
                              
                              
                           

                           
                           
                              	CTI Server	
                              
                              	
                                 Enter the name or IP address of the CTI server.

                                 
                              
                              
                           

                           
                           
                              	LDAP Phone Attributes
                              
                              	
                                 Use the fields in this section to configure LDAP attributes for Phone Control and Presence.

                                 
                              
                              
                           

                           
                           
                              	Outgoing
                              
                              	
                                 Enter the LDAP phone attributes to populate for a Sametime contact. This option allows a user to call phone numbers found
                                    in LDAP for the specified LDAP attributes. For example: telephonenumber(Work), mobile(Mobile), pager(Pager). Beside the attribute,
                                    the text in parentheses () is the label that is displayed next to the phone number in the user interface (menu). for example,
                                    the phone number that is retrieved from attribute "telephonenumber" is displayed as Work (+1 408 902 3232).
                                 

                                 
                              
                              
                           

                           
                           
                              	Incoming
                              
                              	
                                 Enter the LDAP phone attributes to look up a contact. Typically, this option is used to resolve an incoming phone number into
                                    a contact. For example: telephonenumber, mobile
                                 

                                 
                              
                              
                           

                           
                           
                              	Phone Status Settings
                              
                              	
                                 Use this section to configure the phone presence feature.

                                 
                              
                              
                           

                           
                           
                              	 Cisco Unified Presence Server
                              
                              	
                                 Enter the name or IP address of the Cisco Unified Presence servers, if you choose to enable phone status. 

                                 
                              
                              
                           

                           
                           
                              	Sametime User ID Mapping
                              
                              	
                                 Choose one of the following options:

                                 
                                 
                                    	Use LDAP Attribute: Select this option to use the LDAP attribute as the User ID in the Cisco Unified Presence server. Choose this attribute when
                                       the attribute is contained in  the Sametime Internal user ID.
                                       
                                    

                                    
                                    	Use Business Card Attribute: Select this option to use the Business Card attribute as the user ID in the Cisco Unified Presence server. 
                                       
                                    

                                    
                                 

                                 
                              
                              
                           

                           
                           
                              	Domain Name	
                              
                              	
                                 Specify a domain name for Cisco UC Integration for IBM Sametime to use to make presence subscription request to Cisco Unified
                                    Presence.
                                 

                                 
                              
                              
                           

                           
                           
                              	Domain Name Options
                              
                              	
                                 Select one of the following options:
                                    
                                       	Replace Sametime-mapped domain with Cisco Unified Presence domain: The Integration replaces the Cisco Unified Presence subscriber domain that was mapped in Sametime with the Cisco Unified Presence
                                          domain you specify
                                          
                                       

                                       
                                       	Append Cisco Unified Presence domain if not already specified: If there is no domain present in the Sametime-mapped Cisco Unified Presence subscriber ID, then the Integration appends the
                                          domain name you specify to the ID
                                          
                                       

                                       
                                       	Append Cisco Unified Presence domain: Regardless of whether the Sametime-mapped Cisco Unified Presence subscriber ID exists or not, the Integration appends the
                                          domain name you specify to the ID
                                          
                                       

                                       
                                    

                                    
                                 

                                 
                              
                              
                           

                           
                           
                              	Phone Number Retrieval -  Retrieve Phone Numbers for Contacts at Startup
                              
                              	
                                 Uncheck this check box to
                                    disable preloading phones from LDAP. Disabling this option can cause a minor delay
                                    in LDAP search response when the user requests a listing of
                                    available phones.
                                    
                                 

                                 
                              
                              
                           

                           
                           
                              	Logging - Enable Detailed Logging
                              
                              	
                                 Check this check box to have user log files include more detailed information
                                    by default. Note that detailed logging affects performance. For best performance, enable detailed logging only in lab environments
                                    or when debugging a specific issue.
                                 

                                 
                              
                              
                           

                           
                        
                     

                     
                  
               

               
               
                  	Step 5  
                     
                  
                  	On the File menu in the Configuration Tool window, select Save.
               

               
               
                  	Step 6  
                     
                  
                  	On the File menu in the Configuration Tool window, select Exit. 
                     
                        
                           	Note   
                                 
                                 
                           	
                              Confirm that you have saved your changes in the Cisco Unified
                                 Communications with IBM Lotus Sametime Configuration Tool window.
                                 Otherwise, all unsaved changes will be lost when you close the
                                 window.
                                 
                              

                              
                           
                        

                     

                     
                  
               

               
               
                  	Step 7  
                     
                  
                  	For configuration changes to take effect, either set up IBM Sametime to automatically update users by using a push update,
                        or instruct users to update the plug-in from their IBM Lotus client.
               

               
            

         

         

         
      

      
      
      
         
      

      
      
      
   
      
      
      Credential Synchronization

      
         Cisco UC Integration for IBM Sametime 9.5 provides credential synchronization across Cisco Unified Communications services
            such as Cisco Unified Communications Manager, the IM and Presence Service, and Cisco Unity Connection. Credential synchronization
            ensures that when credentials for one service are changed, those same credentials will be automatically synchronized to other
            configured services.
         

         
         The credentials that users enter to log in to Cisco UC Integration for IBM Sametime depend on how you configure your system:

         
         
            	If you do not synchronize user accounts, then users must enter their credentials for  each of their servers individually.
               
            

            
            	If you synchronize user accounts with Sametime, then Cisco UC Integration for IBM Sametime automatically logs  the user in
               to their phone, phone status, and voicemail accounts with their Sametime credentials.
               
            

            
            	If you configure Cisco UC Integration for IBM Sametime to use synchronized Cisco UC credentials, then users enter their Cisco
               UC credentials once and the integration uses these credentials to log  users in to their phone, phone status, and voicemail
               accounts.
               
            

            
         

         
      

      
      
      
         
         	Configure synchronization for Phone Control and Presence

         
      

      
      
      
         
      

      
      
      
   
      
      
      Configure synchronization for Phone Control and Presence

      Procedure

         
            
               
                  	Step 1  
                     
                  
                  	Start the Configuration Tool and click the Phone Control and Presence tab.
               

               
               
                  	Step 2  
                     
                  
                  	Choose one of the following options: 
                     
                        	No synchronization: Select this option if you do not intend to synchronize passwords for users.
                           
                        

                        
                        	Sametime Credentials: Select this option if users have the same user ID and password for the IM and Presence Service and Sametime Connect, and
                           you want to set these fields for all users.
                           
                        

                        
                        	 Synchronized Cisco UC Credentials: Select this option if users have the same user ID and password for the IM and Presence Service and Sametime Connect, and you
                           want to set these fields for all users.
                           
                        

                        
                     

                     
                     

                     
                  
               

               
               
                  	Step 3  
                     
                  
                  	Save the new configuration.
               

               
            

         

         

         
      

      
      
      
         
      

      
      
      
   
      
      
      Phone Number Retrieval

      
         
            Cisco UC Integration for IBM Sametime can  retrieve phone numbers in bulk from LDAP at startup or per contact as needed. Configure
               this with the Retrieve Phone Numbers for Contacts at Startup check box in the Phone Number Retrieval area. This check box
               is selected by default. 
            

            
            To reduce the load on the LDAP server at start-up time and disperse the load throughout the day, uncheck this check box. This
               disables retrieval of all phone numbers in bulk from LDAP. Taking this action might require a user to open the phone call
               menu twice before phone numbers for the contact are visible.  This will only occur once per contact, per login session.
            

            
         

         
      

      
      
      
         
      

      
      
      
   
      
      
      Enhanced LDAP Search Options

      
         
            If you leave the Incoming or Outgoing field blank in the LDAP Phone Attributes area on the Phone Control and Presence tab
               of the Configuration Utility, this affects LDAP phone searches. The effects are as follows:
            

            
            
               	If the Incoming field is left blank, no LDAP search is performed on incoming calls to resolve the phone to a Sametime contact.
                  
               

               
               	 If the Outgoing field is left blank, no LDAP search is performed to pre-load values or in real time when the context menu
                  is used.
                  
               

               
            

            
         

         
      

      
      
      
         
      

      
      
      
   
      
      
      Enable Live Text Support

      
         
            Cisco UC Integration
               with IBM Lotus Sametime supports Click to Call from Live Text. Live Text must be enabled with a policy
               that makes the feature available to users. Perform the following procedure to
               enable Live Text:
            

            
         

         Procedure

         
            
               
                  	Step 1  
                     
                  
                  	Open the IBM Domino Administrator application.
                        
               

               
               
                  	Step 2  
                     
                  
                  	Add the new policy.
               

               
               
                  	Step 3  
                     
                  
                  	Select the Basics tab.
               

               
               
                  	Step 4  
                     
                  
                  	Enter a name for the policy in the Policy name field.
               

               
               
                  	Step 5  
                     
                  
                  	In the Policy type field, select Organizational.
               

               
               
                  	Step 6  
                     
                  
                  	In  the Desktop settings area, select the New button.
               

               
               
                  	Step 7  
                     
                  
                  	In the Enable Live Text field, select Enable.
               

               
               
                  	Step 8  
                     
                  
                  	Select Save and Close.
               

               
               
                  	Step 9  
                     
                  
                  	Save the new policy.
               

               
               
                  	Step 10  
                     
                  
                  	Apply the new policy.
               

               
            

         

         

         
      

      
      
      
         
      

      
      
      
   
      
      
      Chapter 5. Troubleshooting
      

      
      
         
         	Create Problem Report

         
         	Enable Logging in the Configuration Utility

         
         	Disable Extra IBM Call Option in Live Text Window

         
         	Troubleshoot Phone Presence Issues

         
      

      
      
      
   
      
      
      Create Problem Report

      
         
            If unexpected or unresolvable issues occur, users can generate reports with detailed configuration and logging information.
               These reports can assist Cisco TAC in troubleshooting.
            

            
            
               
                  	[image: ../images/note.gif]
Note
                  	



                     Enable detailed logging should not be checked in the Configuration Utility for a production deployment. Detailed logging should
                        be enabled only on a client as necessary, so that a user can generate the logs to capture the issue  and then turn logging
                        off when log collection is
                        complete.
                        
                     

                     
                     Instruct the user to restart IBM Sametime or IBM Lotus Notes after they enable detailed logging,
                        because  critical information, such as the configuration
                        settings, is in the log files at startup.
                     

                     
                     

                  
               

            

            
            When you troubleshoot issues with the plug-in, inspect the
               following log files for errors and warnings:
            

            
            
               	IBM Sametime—trace-log-0.xml and error-log-0.xml
                  
               

               
               	IBM Lotus Notes—trace-log-0.xml and error-log-0.xml
                  
               

               
            

            
            To view the log location, choose File > Preferences and then Cisco > General. 
            

            
            To obtain a report:

            
         

         Procedure

         
            
               
                  	Step 1  
                     
                  
                  	  Enable detailed logging.  
               

               
               
                  	Step 2  
                     
                  
                  	Reproduce the issue.
               

               
               
                  	Step 3  
                     
                  
                  	To create  a problem report, choose Create Problem Report from the Help menu.
               

               
            

         

         

         
      

      
      
      
         
      

      
      
      
   
      
      
      Enable Logging in the Configuration Utility

      
         If you report an issue to Cisco Support, you should enable logging to provide valuable data to support engineers as they diagnose
            the issue. You can enable logging for all users with the Configuration Utility. The detailed logging feature allows you to
            capture logs separately for  voicemail or for Phone Control and Presence:  
         

         
         
            	For voicemail logging, click the Voicemail tab and then check the Enable Detailed Logging check box.
               
            

            
            	For Phone Control and Presence logging, click the Phone Control and Presence tab and then check the Enable Detailed Logging check box.
               
            

            
         

         
         
            
               	[image: ../images/note.gif]
Note
               	



                  Remember that the log files will continue to accumulate after you enable logging. Be certain to uncheck the Enable Detailed
                     Logging check box when you no longer require logs.
                  

                  
                  

               
            

         

         
      

      
      
      
         
      

      
      
      
   
      
      
      Disable Extra IBM Call Option in Live Text Window

      
         
            The Live Text feature allows you to open a call menu when you click on a live text object (the user can right-click to open
               a window or left-click on a drop-down arrow beside the live text to open a menu. Depending on the  IBM Sametime setup for
               your organization, the window or menu can display an extra Call option.
            

            
             To disable the extra Call option, follow this procedure:

            
         

         Procedure

         
            
               
                  	Step 1  
                     
                  
                  	 Contact IBM and obtain the hot fix binary MEWE-8UEB9U. Then install the hot fix. 
                     

                     
                  
               

               
               
                  	Step 2  
                     
                  
                  	 Configure the following managed settings to create a boolean flag. The flag, when set to true, forcefully disables LiveText
                        call actions: 
                     
                        	 Setting: disableLiveTextCallAction
                           
                        

                        
                        	 Setting group name: com.ibm.collaboration.realtime.telephony.ui
                           
                        

                        
                        	 Setting type: Boolean
                           
                        

                        
                     

                     
                     
                        
                           	Note   
                                 
                                 
                           	
                              If an extra phone icon appears on the Sametime button bar, disable TCSCPI or SUT.

                              
                              IBM Sametime version to 8.5.2 or later is required to fix the extra phone icon issue.

                              
                              See IBM documentation for more information.

                              
                           
                        

                     

                     
                  
               

               
            

         

         

         
      

      
      
      
         
      

      
      
      
   
      
      
      Troubleshoot Phone Presence Issues

      
         
            Prevent issues related to phone presence with one of the following methods:

            
            
               	Create a file called managed-settings.xml in the root directory
                  of your update site, which is the same directory that contains your
                  site.xml file. If you are not using auto-push to deploy the integration, you only require the managed-settings.xml file in
                  the root directory.
                  The following is an example of the managed-settings.xml file that is configured to enable phone status:
                  
                  
<?xml version="1.0" encoding="utf-8"?>
<ManagedSettings> 
       <settingGroup name="com.ibm.collaboration.realtime">
             <setting name="enableSUT" value="false"/>
             <setting name="enableTelephonyStatus" value="false"/>
             <setting name="enableExtendedStatus" value="true"/> 
       </settingGroup>
</ManagedSettings> 
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Note
                        	



                           You must set the enableExtendedStatus value to true to enable Phone Control and Presence to show
                              phone status .
                              
                           

                           
                           

                        
                     

                  

                  
               

               
               	Ensure that the Lotus Notes file, C:\Program Files (x86)\IBM\Lotus\Notes\framework\rcp\plugin_customization.ini, includes
                  the following lines:
                  com.ibm.notes.branding/enable.update.ui=true
                  com.ibm.collaboration.realtime/enableExtendedStatus=true
                  
               

               
               	 Check that your IM and Presence Service credentials are correct. Also, check for the following error in the details logs
                  (for example, trace-log-0, trace-log-1, trace-log-2):
                  In PhoneStatusManager: Entering OnLoginError...

                  This error could include one of the following components:
                  
                     
                        	Error Component
                        
                        	Meaning
                        
                     

                     
                     
                        	ERR_CUP_UNREACHABLE	
                        
                        	The IM and Presence Service is unreachable.
                        
                     

                     
                     
                        	ERR_CUP_AUTH 
                        
                        	The IM and Presence Service credentials are incorrect.
                        
                     

                     
                     
                        	ERR_JABBER_UNREACHABLE 	
                        
                        	The IM and Presence Service is reachable, but it cannot connect to Jabber services that are running on the CUP server.
                        
                     

                     
                  

                  
               

               
               	Assign the domain (the same one as was provided on the CUP server) value for the parameter Domain Name in the Cisco UC Integration
                  for IBM Sametime Administration Utility.
                  
               

               
               	Assign a unique value for the IM and Presence Service user ID for whatever LDAP attribute you use.
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Note: You must save the Voicemail tab and the Phone Control and Presence tab when you make changes to this tab.
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